
    


    
    Top
   
    







  
    
      
        
          
            
          
        
        
          
          
            PDFelement: PDF Editor, Scanner

            Edit, Convert, Annotate PDF

            Edit, Annotate PDF

          

        

      

      OPEN
      OPEN
    

  




  
    
      
        
          wondershare
        

        
          
            
          
          
            
          
        
        
          	
  
    Video Creativity
    
      
    
  
  
    
      
        Video Creativity Products

        
          
          
            Filmora
            Complete video editing tool.

          

        
        
          
          
            DemoCreator
            Efficient tutorial video maker.

          

        
        
          
          
            UniConverter
            High-speed media conversion.

          

        
        
          
          
            Virbo
            Powerful AI video generator.

          

        
        
          
          
            Presentory
            AI video presentation maker.

          

        
        View all products
      

      
        Explore

        	Overview
	Video
	Photo
	Creative Center


      

    

  


	
  
    Diagram & Graphics
    
      
    
  
  
    
      
        Diagram & Graphics Products

        
          
          
            EdrawMax
            Simple diagramming.

          

        
        
          
          
            EdrawMind
            Collaborative mind mapping.

          

        
        
          
          
            EdrawProj
            A professional Gantt chart tool.

          

        
        
          
          
            Mockitt
            Design, prototype & collaborate online.

          

        
        View all products
      

    

  


	
  
    PDF Solutions
    
      
    
  
  
    
      
        PDF Solutions Products

        
          
          
            PDFelement
            PDF creation and editing.

          

        
        
          
          
            Document Cloud
            Cloud-based document management.

          

        
        
          
          
            PDF Reader
            Simple and free PDF reading.

          

        
        
          
          
            HiPDF
            Free All-In-One Online PDF Tool.

          

        
        View all products
      

    

  


	
  
    Data Management
    
      
    
  
  
    
      
        Data Management Products

        
          
          
            Recoverit
            Lost file recovery.

          

        
        
          
          
            Repairit
            Repair broken videos, photos, etc.

          

        
        
          
          
            Dr.Fone
            Mobile device management.

          

        
        
          
          
            MobileTrans
            Phone to phone transfer.

          

        
        
          
          
            FamiSafe
            Parental control app.

          

        
        View all products
      

    

  


	Explore AI
	Business
	Shop
	Support
	
              Sign in
            
	
              
              
                
                Account Center
                Sign out
              

            


        

      

    

  
  
    
      
        
          
            
            PDFelement
          
        

        
          
            
          
          
            
          
        
        
          	
              
                Products
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Desktop

                            
                            	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  PDFelement for Windows
                                
                              
	
                                
                                  
                                    
                                  
                                  PDFelement for Mac
                                
                              
	
                                
                                  
                                    
                                  
                                  PDF Reader for Windows
                                
                              


                          

                        

                        

                        
                          
                            Mobile App

                            
                            	
                                
                                  
                                    
                                  
                                  PDFelement for iPhone/iPad
                                
                              
	
                                
                                  
                                    
                                  
                                  PDFelement for Android
                                
                              
	
                                
                                  
                                    
                                  
                                  InstaScan - PDF Scanner for iPhone
                                
                              


                          

                        

                        

                        
                          
                            Cloud & SDK

                            
                            	
                                
                                  
                                    
                                  
                                  Document Cloud
                                
                              
	
                                
                                  
                                    
                                    
                                  
                                  PDFelement Pro DC
                                
                              
	
                                
                                  
                                    
                                    
                                  
                                  PDFelement SDK
                                
                              


                          

                        

                        

                        
                          
                            
                              What's New
                            

                            
                            	
                                
                                  
                                
                              


                          

                        

                      

                    

                  

                

              

            
	
              
                Solutions
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Educational Users

                            
                            	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                  
                                  Read PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                  
                                  Annotate PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  Create PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  Combine PDF
                                
                              


                          

                        

                        

                        
                          
                            Personal Users

                            
                            	
                                
                                  
                                    
                                    
                                    
                                  
                                  Convert PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                  
                                  Edit PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                  
                                  Compress PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                  
                                  Organize PDF
                                
                              


                          

                        

                        

                        
                          
                            Professional Users

                            
                            
                              	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    PDF Form
                                  
                                
	
                                  
                                    
                                      
                                      
                                    
                                    Sign PDF
                                  
                                
	
                                  
                                    
                                      
                                      
                                    
                                    Protect PDF
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    Batch PDF
                                  
                                


                              	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    PDF OCR
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                      
                                    
                                    Extract PDF Data
                                  
                                
	
                                  
                                    
                                      
                                    
                                    AI-Powered PDF Tool
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                    
                                    eSign PDFs Legally
                                  
                                


                            

                          

                        

                        
                          
                            
                              Industries
                            

                            
                            
                              	
                                  Education
                                
	
                                  IT Service
                                
	
                                  Legal
                                
	
                                  Healthcare
                                


                              	
                                  Financial
                                
	
                                  Government
                                
	
                                  Publishing
                                
	
                                  Freelancer
                                


                            

                          

                        

                      

                      
                        All PDF Features
                      

                    

                  

                

              

            
	
              
                Resources & Help
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Hot Topics

                            
                            	
                                Top List
                              
	
                                Mac Software
                              
	
                                PDF Apps
                              
	
                                OCR PDF Tips
                              
	
                                Sign PDF Tips
                              
	
                                Edit PDF like Word
                              
	
                                PDF Converter Tips
                              
	
                                PDF Compressor Tips
                              


                            Find More Topics
                          

                        

                        

                        
                          
                            
                              
                                Why PDFelement

                                
                                	
                                    Customer Stories
                                  
	
                                    PDF Software Comparison
                                  


                              

                            

                            
                              
                                Better Use

                                
                                	
                                    Tech Specs
                                  
	
                                    Contact Support
                                  


                              

                            

                            
                              
                                User Guide

                                
                                	
                                    PDFelement for Windows
                                  
	
                                    PDFelement for Mac
                                  
	
                                    PDFelement for iOS
                                  
	
                                    PDFelement for Android
                                  


                              

                            

                            
                              
                                 

                                
                                	
                                    PDF Reader
                                  
	
                                    Document Cloud
                                  
	
                                    InstaScan for iPhone
                                  


                              

                            

                          

                        

                        

                        
                          
                            Explore More

                            
                            	
                                Reviews
                                See what our users say.

                              
	
                                Free PDF Templates
                                Edit, print, and customize free templates.

                              
	
                                PDF Knowledge
                                PDF-related information you need.

                              
	
                                Download Center
                                Download the most powerful and simple PDF tools.

                              


                          

                        

                      

                    

                  

                

              

            
	
              Upgrade
            
	
              Business
            
	
              Download
              Download
              Pricing
              Pricing
            
	
              
                
                  
                    
                    
                  
                
              
            


        

      

    

  


 




          
          
            
              
                
                  Edit PDF Solutions


  	
              
                  Editing Tips

              

              
                  	Free PDF Editor
	Free PDF Writer
	How to Edit File in PDF
	Open Source PDF Editor
	Spell Check PDF
	Copy and Paste from PDF
	Move and Align Objects
	Can't Edit PDF
	PDF Metadata Viewer
	Edit Metadata
	PDF Graphic Editors
	Flatten PDF
	 Online PDF Editor
	Flatten PDF Online
	Edit PDF in Chrome 
	Ubuntu PDF Editor
	Edit PDF on Linux
	Snapshot PDF


              

          
	
            
                PDF Watermark

            

            
                	PDF Watermark Remover
	Remove Watermark from PDF
	Add Logo to PDF
	Add Watermark in PDF
	Free Remove Watermark from PDF
	Online Remove PDF Watermark
	Watermark PDF Online


            

        
	
          
              PDF Background

          

          
              	Remove Background
	 Create PDF with Transparent Background
	Change Background Color
	Color PDF
	Add Background to PDF


          

      
	
        
            PDF Image

        

        
            	Add Image to PDF
	Add a GIF to PDF
	Flip a PDF Image
	Add PNG to PDF
	Remove PDF Image
	Edit PDF Image
	Paste Image into PDF
	Mirror Image in PDF
	Add Image to PDF Online
	Add Picture to PDF
	Crop Image in PDF
	Manage PDF Layers
	Insert Image to PDF
	Insert Picture into PDF
	Add Photo to PDF
	PDF Image Editor
	Insert Photo into PDF


        

    
	
        
            PDF Text

        

        
            	Edit PDF Text
	Insert Text into PDF
	Increase Font Size
	Edit PDF Font
	Change Font Color
	Copy Text from PDF
	Edit Font Size
	Select Text in PDF
	Delete Text from PDF
	Change Font in PDF
	Edit PDF Text Online
	Change Text Color
	Change Font Size


        

    
	
        
            PDF Link

        

        
            	Add Link to PDF 
	Hyperlinks Not Work in PDF
	Create URL for PDF
	PDF Link to Page
	Embed Video in PDF
	Edit Link in PDF
	Remove Link from PDF
	Create Link for PDF 
	Add Audio to PDF
	Add Video in PDF


        

    
	
        
            PDF Page Numbers

        

        
            	Add Page Numbers to PDF
	Add Header and Footer to PDF
	Remove Footer from PDF
	Add Bates Numbering
	Change Page Numbers in PDF
	Insert Page Number in PDF
	Start Page Number on Page 3
	 Add Page Numbers Online


        

    
	
        
            Translate PDF

        

        
            	Translate PDF
	Translate Scanned Document
	Google Translate PDF
	English to Hindi
	English to French
	French to English
	English to Spanish
	Spanish to English
	Japanese to English
	German to English


        

    


  Try It Free    Try It Free  Try It Free


                

              

              
                  
            

          
          


    
		
		  	  	    
      
    
		
      
        
          How to Add Text on PDF Easily and Quickly

        

      

      
        

          
            
              
            

            
              
                
                  
                    Audrey Goodwin

                  

                

                
                  
                    2024-01-08 18:46:10 • Filed to:
                    PDF Text
                    • Proven solutions
                  

                

              

            

          

          After creating a PDF file, you may notice that some important points missing from the document need to be added. This may be difficult if you don't have the appropriate software to edit and insert text into an existing PDF file. Or you want to add text on PDF to implement the content. This article explains how to add text to PDF online or offline. Wondershare PDFelement - PDF Editor is highly recommended as it can insert text in PDF, add text box to PDF and more.
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How to Add Text to PDF

Being an all-in-one PDF editor, PDFelement is undoubtedly referred to as a go-to solution for all kinds of edits across a PDF file. It can add text to PDF and lets you customize text font, color size, etc. Moreover, it can add a fillable text box in PDF, too.

While being a text editor, there are a lot of other features that are provided across the platform. Users can not only edit text in exsiting PDF, but they can also work across the images and links of the file.

Along with the editing features, there are many other notable options within the platform. It allows users to insert comments to PDF, add highlight to PDF, add strikethrough and more.

This all-in-one PDF text editor offers users to scan images with its OCR tool so that users can add text to a scanned PDF. It indeed makes PDFelement one of the best options to add text to PDF and perform several notable changes in PDF documents.
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Step 1. Import PDF into the PDF Text Editor

Before doing anything else, you need to download PDFelement on your computer and install it. Once installed, you can launch the program. With its easy-to-use interface, you can simply drag your document into the program or click on the "Open files" button. This will be directed to the computer folder, you can search and select the PDF file to edit. After choosing it, click on the "Open" button.



Step 2. Add Text on PDF

Once you have opened the PDF file, click on the "Edit" tab. From there, move the cursor to where you want to insert text. The you can start typing to add text to the PDF document.



Step 3. Add Text Box to PDF

If you want to add a new text box to a PDF, you need to click the "Add Text" button, then click anywhere on your document to insert the text box and type in the content. Once you are done, you can save the changes.
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Step 4. Format Text in PDF

After adding text in PDF, you can also change the font, font size, text color, word space, and line space, and align the texts. Additionally, it also allows you to add superscripts and subscripts in your PDF document. 
What's more, PDFelement also supports adding, deleting, rotating, clipping, and replacing images in PDF by clicking on the "Edit" button.



How to Add a Fillable Text Box to PDF

To add a fillable text box with PDFelement, follow these steps:

Open the PDF document in PDFelement. Click on the "Form" tab in the top menu bar. Select "Text Box", click, and drag the cursor to draw the text box where you want it on the page. Then save the document to apply the changes.



Besides editing PDF files, PDFelemen allows you to add comments to PDF documents with ease as well. You can highlight, draw markups, and add notes by clicking the "Comment" tab to select any of the tools for annotation. 
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How to Add Text to PDF Online

Many ways can be implemented to add text to PDF. Regardless, it is essential to select such ways which are comprehensive and easy to execute. With this in mind, users can consider the method that explains how to add text to PDF online for free.

HiPDF is known for its impressive online interface and vast features compared to other online PDF editors.

When the question comes across adding text to PDF document using HiPDF, the user can follow the steps as shown below.

Step 1. Open Text Editor Online

You need to access the official website of HiPDF across your browser and open its "Edit PDF" tool, which allows you to add text, images, and more to PDF.



Step 2. Upload PDF File to Text Editor Free

Following this, import the file from the device by tapping on "Choose File" or dragging and dropping the file onto the interface. Once the file is added onto HiPDF, it opens on a new screen.



Step 3. Add Text on PDF Online Free

The user can select the "Add Text" option to add text across a text box that shows on the screen. The user can choose the font style, and color and set the size of the text box as per discretion. Once added, tap on "Apply" to save the changes across the file. Once the changes are applied, tap on "Download" to download the edited PDF file.





Should I Add Text to PDF Online?

An online PDF editor has several advantages over traditional desktop software. Firstly, it is more accessible, as it can be used from any device with an internet connection. This means that you can edit PDF documents online, without needing to download specialized software on your device just to make simple edits to PDF. Secondly, online PDF editors are often more affordable, as they typically offer a subscription-based pricing model. Overall, using an online PDF editor offers convenience, affordability, and collaboration, making it a popular choice for many people. However, if security is a top priority for you, a desktop PDF editor is a better option.





How to Add Text to PDF on Mac

Although online solutions are quite proficient, they require a running internet connection. Under such cases, an offline editor is preferred. PDFelement for Mac features itself as a proficient offline solution that can add text to PDF files on Mac. The platform is known for its extensive features within a unique and intriguing user interface.

To understand how to add text to PDF using PDFelement for Mac, you need to follow the steps provided below.
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Step 1. Download and install PDFelement on your Mac and launch it. From "Open File," you can open the PDF document that you wish to edit.



Step 2. As the PDF file is imported successfully on the platform, you need to select the "Text" button. On the toolbar that opens following this, click on the "Add Text" button to add new text within the document. Tap anywhere across the document to make a text box. A box shall appear on the screen. Set the font, size, layout, and color for the text added across the PDF.



Step 3. When you add text across their PDF document, they need to hover their cursor across the "File" tab to select "Save" or "Save As..." from the drop-down menu.

Read More: How to Add Text to PDF on Mac

Tip: How to Add a Text Box to a PDF on Mac Preview

By following the steps below, you can easily add a text box to a PDF document using Mac Preview. This feature allows you to insert additional information, comments, or annotations, making your PDFs more interactive and informative.

Step 1. Open a PDF file in Mac Preview. Click on the "Markup Toolbar" icon, which looks like a toolbox and is located at the top of the Preview window. If you don't see the Markup Toolbar, go to "View" in the menu bar and select "Show Markup Toolbar."

Step 2. From the Markup Toolbar, click on the "Text Box" icon. It resembles an 'A' inside a square.

Step 3. Locate where you want to add the text box within the PDF. Click and drag to create a rectangular area for the text box.

Step 4. Once the text box is created, you can start typing to add text you need.

Step 5. After adding the text box, you can save the changes to the PDF by selecting "File" in the menu bar and choosing "Save" or "Export."





How to Add Text in PDF Files on Mobile

To add text in PDF on an iPhone or Android phone, you need to get a PDF editor app for your device. Here we will show you how to add text to a PDF on a mobile device using PDFelement for iOS, follow these steps:



        
            
                
                    
                
                
                    
                

            

            
                
                    
                
                
                    
                

            

        

    

    
        
            
        

        
            
        

    

Step 1. Download and install PDFelement on your device from the App Store.

Step 2. Open the PDF file you want to add text to. Then tap on the "Edit" button at the bottom of the screen. Select the "Add Text" tool from the toolbar.

Step 3. Tap on the location in the PDF where you want to add text. Type the text you want to add. Adjust the font, size, and color of the text as needed.







How to Add Text in Adobe Acrobat?

Adding text to a PDF document using Adobe Acrobat is a relatively straightforward process. Here's a step-by-step guide on how to do it:

Step 1. If you have Adobe Acrobat on your computer, launch the program and open PDF document you want to add text to.

Step 2. In Adobe Acrobat, look for the "Edit PDF" tool in the right-hand pane. Click on it to enter the editing mode.

Step 3. Once in editing mode, click on the "Add Text" tool and click anywhere on the PDF document where you want to add the text. Then click inside the text box and start typing the text you want to add.

Step 4. Once you've added and formatted the text, save your changes. Go to "File" > "Save" or "File" > "Save As" to save the edited PDF with the added text.



Keep in mind that extensive editing of a PDF's content could potentially affect the formatting and layout of the document.





FAQs



1. How do I add text to a PDF without Acrobat? 



There are several ways to add text to a PDF without using Acrobat. One way is to use an Acrobat alternative like PDFelement, which allows you to add text, images and more on PDF as easily as using Acrobat. The second option is to use free online PDF editors such as HiPDF or Smallpdf. These tools allow you to upload your PDF and add text boxes, comments, or annotations to it.








2. Can I add text to a PDF for free?



One option to add text to PDF online is to use a word processor or text editor to create a document with the text you want to add, and then convert it to PDF using a free online converter or your computer's built-in PDF printer. You can then use the same online PDF editors to add the PDF file to your original document. This option may require more technical knowledge and may not be as user-friendly as using a PDF editor like PDFelement, but it is a viable alternative for those who do not have access or do not want to pay for a PDF editor.








3. How do I add interactive text to a PDF?



To add interactive text to a PDF, you can use PDFelement. First, open the PDF in PDFelement and select the "Form" tool. Then, click on the "Text Field" option and place the cursor where you want to add interactive text. You can customize the text field properties and add validation options as needed. Finally, save the PDF with the interactive text added.
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